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About this document 
Please note:  This document pertains to using the UI Thesis Template with Word 2007– please check for updated versions of this 
document on our website (http://cs.its.uiowa.edu/sda/index-thesis.shtml) which will contain additional information, directions and 
screen shots not yet included in this document.  We welcome any feedback and/or suggestions pertaining to this document (e.g., 
What is helpful/not helpful? Are there any steps which are not clear?  Is there any additional information or directions you would 
like to see included in this document?).  Please direct feedback and/or suggestions pertaining to this document to  
its-helpdesk@uiowa.edu, and include “UI Thesis Template for Word 2007 Feedback” in the Subject line of your message. 

What is included in this document? 
• Step-by-step instructions for attaching the UI Thesis Template to your thesis documents  

• Information pertaining to macros (which will allow you to  automatically create your Preliminary Pages and Doctoral 
Abstract within minutes) and macro security settings in Word 2007 

• Step-by-step instructions to assist you with the most common thesis formatting actions 

• Definitions of the UI Thesis Template Styles 

• Best Practices to help you avoid problems during your document creation and formatting process 

• Resources for assistance 

What is a template? 
A template is a unique Microsoft Word document which contains predefined content such as styles, formatting, macros, customized 
toolbars, text and design elements.  When you attach a specific template to a document, the document will then have access to the 
items contained within that particular template (e.g., styles, macros, toolbars, etc.). 

Many people are unaware that every Microsoft 
Word document is based on a template.  When 
you create a new document in Word, you are 
presented with the New Document dialog box 
(as shown on the right).  The New Document 
dialog box allows you to select the type of 
document you would like to create.  If you 
select Blank Document, your document will be 
created based on the Normal template 
(Normal.dotx in Word 2007, or Normal.doc in 
Word 2003 and earlier versions).  You also 
have the option to create a new document 
based on one of the other templates provided. 
If a new template (such as the UI Thesis 
Template) is attached to an existing document, 
the document will then use the UI Thesis 
Template’s styles, content and page layout.  It 
will no longer be attached to the Normal 
template. 

 
Figure 1.  Microsoft Word “New Document” dialog box 

To help you understand the relationship between your document and your template, here’s an analogy:  Think of your document as 
your car, and the template as your car’s dashboard.  Your car’s dashboard is attached to your car and contains instrumentation and 
controls you utilize while driving – the speedometer, odometer, fuel gauge, radio, and various other components.  Although you are 
accessing and using the components contained on your dashboard, you are never actually opening up the dash to access these 
components or controls - rather, you access them from the dashboard where they remained attached.  The same is true with a 
template – your template (dashboard) will be attached to your document, and you will utilize the toolbars, macros and styles 
(speedometer, odometer, radio, etc.) contained within the template.  However, you will never actually open the template file itself 
and manipulate it by typing into it, pasting text into it, etc.  As with your dashboard and your car, your template should be attached 
to your document, and should not be opened. 

Why should I use templates to format my documents? 
Although templates are useful tools for ensuring consistency when formatting your documents, many people are unfamiliar with 
styles.  As a result they rely on direct formatting to format their documents.  By reviewing the information and external resources 
provided in this document, you will attain a basic understanding of template styles and the ability to use them to format your 
documents.  To aid in this process, we have explained how styles are more advantageous than direct formatting. 
 

http://cs.its.uiowa.edu/sda/index-thesis.shtml�
mailto:its-helpdesk@uiowa.edu�
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 Styles Direct Formatting 
Time: With styles, you have the ability to format words or 

paragraphs exactly as you want with one click.   
With direct formatting, you must touch each and 
every word, paragraph and/or page individually to 
include any formatting details you would like to 
specify. 
 

Consistency: By applying a style to a word or paragraph, you 
ensure that it is formatted exactly the same as 
others of its type or style.   

With direct formatting, you must manually apply the 
font and any additional paragraph formatting to 
each section.  In addition to being time-consuming, it 
is also difficult to be consistent with this method. 
 

Effort: When you change a style, you change all words or 
paragraphs associated with that style. 

If you change your mind on formatting you’ve done 
in several sections of your document, you must 
repeat the process for each word or paragraph. 

For more information pertaining to styles, go to http://office.microsoft.com or the Help menu, and search for “Style basics in Word”. 

Getting Started 
Before you begin… 
Before you begin formatting your thesis documents, you will need to carefully review the information in this section, and obtain the 
required items listed below.   

1. Bookmark the ITS Thesis and Dissertation website for future reference: http://cs.its.uiowa.edu/sda/index-thesis.shtml   

2. Obtain the three required items from the Thesis Template Checklist, which include: 
a. Thesis Template Documentation 

The UI Thesis Template for Word 2007 document will assist you with the information you need to format your 
documents using the styles provided in the UI Thesis Template.  Step-by-step instructions will help you with the 
most common thesis formatting actions. 

b. UI Thesis Template Style Definitions 
The UI Thesis Template Style Definitions provides you with a list of the most common styles contained in the 
template, and explains what formatting is applied when the style is selected.  It will also assist you with 
determining the appropriate style for sections within your document. The UI Thesis Template Style Definitions can 
be found on page 22 of this document.  

c. UI Thesis Template for Windows (http://cs.its.uiowa.edu/sda/thesis-templates.shtml) 
The UI Thesis Template was created to help you format your thesis documents consistently and with ease.  Please 
refer to the Download the UI Thesis Template section below for important information pertaining to downloading 
and attaching the UI Thesis Template. 

Please note:  You should never open the “UI Thesis Template.dot” file and type directly into it (or paste text directly into it) – 
doing so can result in the template no longer functioning as a template, and puts you at risk for incorrectly formatted items 
and possible corrupt documents.  Please follow the step under “Attach the UI Thesis Template to your documents” to learn 
how to correctly attach the template to your new or existing documents. 

Download the UI Thesis Template 
If you have not yet done so, please go to http://cs.its.uiowa.edu/sda/thesis-templates.shtml to download a copy of the template.  
Due to differences in the Graduate College formatting requirements and the way Microsoft Word handles formatting, the template 
does NOT match the Graduate College requirements 100%.  While it is close, everyone will likely need to do some additional manual 
formatting to get their thesis in final form. 
Please note:  These are compressed files which will need to be unzipped in order to view them after download. To obtain a copy of 
WinZip for this purpose, please go to: http://www.download.com, search for the WinZip software, and follow their installation 
instructions.  If you need assistance extracting the zipped files, please contact the ITS Help Desk at 384-4357. 
  

http://office.microsoft.com/�
http://cs.its.uiowa.edu/sda/index-thesis.shtml�
http://cs.its.uiowa.edu/sda/thesis-templates.shtml�
http://cs.its.uiowa.edu/sda/thesis-templates.shtml�
http://www.download.com/�
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Attach the UI Thesis Template to your document(s) 
The most important thing to know before you begin formatting your document is how to properly attach the UI Thesis Template to 
your thesis documents.  A common mistake is opening the “UI Thesis Template.dot” file and typing directly within the document (or 
copying text from an existing document and pasting it into the template).  You should never need to open the “UI Thesis 
Template.dot” file for any reason – doing so can result in the template not functioning properly, and increases the risk for corrupt 
files (in other words, you run the risk of experiencing a formatting nightmare).   Instead, you will attach the template to your new or 
existing documents by following the instructions below.   
Please make sure you have downloaded and extracted the UI Thesis Template.dot file before continuing below.  Steps for doing so 
can be found in the previous section. 

To attach the UI Thesis Template to your documents: 
1. Create a New Folder called Thesis to store your new or existing thesis documents and the UI Thesis Template.   

Please note:  Your template will always be available to you when it is located in the same folder as your thesis documents.  
When working on multiple computers, make sure you copy the entire Thesis folder between computers. 

2. Copy the UI Thesis Template.dot file into 
the new Thesis folder. 
Please note: Disregard the “UI Thesis.doc” 
document – this is being phased out and is 
no longer applicable. 

3. Launch Microsoft Word 2007. 

4. If you have thesis documents that you have 
already created, open your thesis 
document now.  Otherwise, create a new 
Word document. 

5. Click the Office Button  and select 
Word Options. 

6. From the Word Options dialog box, click 
Add-Ins. 

7. From the Add-Ins portion of the dialog box, 
find the Manage: drop-down list.  Select 
Templates from the list and click the Go 
button (as shown in Figure 2). 

 
Figure 2.  Step 7 

8. In the Templates and Add-ins dialog box, 
click the Attach button to navigate to the 
Thesis folder. Select the UI Thesis 
Template.dot file, and click the Open 
button to return to the Templates and Add-
ins dialog box. 

9. Place a check in the check box next to 
Automatically update document styles. 

10. Click OK to attach the template and return 
to your document.  You should now see the 
list of styles available on the Add-ins tab. 
Please note:  If a Warning dialog box 
appears concerning Macros, click Enable 
Macros to continue.  Alternatively, if you 
receive an error about macros being 
disabled, see the Macro Security Settings 
section below. 

11. Save your document to the Thesis folder. 
Please note:  If you have already created 
multiple thesis documents, you will need to 
follow steps 5 – 11 for each document. 

 
Figure 3.  Steps 8, 9 and 10 
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As long as you copy your entire Thesis folder between computers, your template will stay attached and you will be able to access the 
thesis styles each time you open the document.  You are now ready to begin applying styles and formatting your documents.  For 
information pertaining to the styles contained in the UI Thesis Template, please refer to the Definition of styles used within the UI 
Thesis Template section of this document. 

Macro Security Settings 
Microsoft defines a macro as “a set of computer instructions that you can record and associate with a shortcut key combination or a 
macro name. Then, when you press the shortcut key combination or click the macro name, your computer program carries out the 
instructions of the macro.”  The UI Thesis Template includes macros which will automatically generate your Preliminary Pages and 
Doctoral Abstract for you based on the information you supply to the resulting questions.  These macros contain the formatting 
needed to meet the Graduate College’s requirements. 

While the macros contained within the UI Thesis Template are safe, there is a potential security risk associated with macros, as a 
person with malicious intent could create a destructive macro and include it in a document to spread a virus.  For this reason, the 
Trust Center will automatically disable macros in a document if it does not contain a digital signature.  With this in mind, you may 
encounter security warnings pertaining to macros after attaching the UI Thesis Template to your document.  Rest assured that the 
macros contained within the UI Thesis Template are safe, and you can modify your security settings to allow the use of macros 
contained within our template.   

For more information about the Trust Center, please click the Office Button , and then “Trust Center” for links to Microsoft’s 
site. 

The following section defines commonly received messages pertaining to macros when using the UI Thesis Template.  Based on the 
warning you have received, follow the most appropriate steps below to adjust your settings. 

Security Warning: Macros have been disabled. 
If you receive a Security Warning after attaching the UI 
Thesis Template to your existing documents (as shown in 
the figure on the right), please follow the steps below to 
adjust your Macro Security settings. 

1. Click the Options… button next to the security 
warning. 

2. In the resulting Microsoft Office Security Options 
window, select Enable this content, and click OK. 

 
Figure 4.  Macro Security Warning 

The macro cannot be found… 
If you attempted to run the Prelims or DocAbsSeparate macro and received an error (as shown below), follow the steps below to 
modify your Macro Security settings: 

1. Click the Office Button and select 
Word Options 

2. Select Trust Center and click the 
Trust Center Settings button. 

3. From the Trust Center, select 
Macro Settings. 

4. Under Macro Settings, click Enable 
all macros.  

Figure 5.  “The macro cannot be found” message 
Please note:  Be sure to change this option back to its original setting after you have run the Prelims or Doctoral Abstract macro. 

Show / Hide Paragraph Marks  , New Line Markers , Tabs , and Spaces  
While working on your documents, we recommend you reveal formatting marks to assist 
you.  To do so, select one of the methods below: 

• Click the Show / Hide marker  in the Paragraph group (under the Home tab), 
OR 

• Press Ctrl + Shift + 8  
Figure 6. Show/Hide marker in Paragraph 
group 
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Turn on Word’s Automatic Save Feature 
The Automatic Save feature is useful in the instance of system or power failure, but is not a replacement for saving and backing up 
your work.  Remember to perform regular backups of your work and to save frequently.   

1. Click the Office Button, and then select Word Options 
2. From the Word Options dialog box, select Save 
3. Place a check next to Save AutoRecover information every x minutes. 

4. Specify how often you would like the program to save your data and program state in the minutes list. 

Page Setup 
Set margins and page number position 
The following steps will walk you through setting your margins and page number position.  The Header and Footer measurements 
control the distance from the edge of the paper to the outer edge of the page numbers.   Adjust the Header and Footer settings per 
the instructions below to fix your page number position (if needed). 
 
Please note:  These steps must be done to any document which was created prior to attaching the template to it. 

1. On the Page Layout tab, select Margins -> Custom Margins 
2. Enter the following numbers/select the following items where appropriate 

• For Portrait pages: 
o On the Margins tab 

 Click to select Portrait Orientation 
 Select Apply to Whole Document (skip this step if 

you wish to only change the margins in the current 
section of your document) 

 Top = 1.0” 
 Bottom = 1.0” 
 Left = 1.5” 
 Right = 1.0” 
 Gutter = 0” 
 Gutter Position = Left 

o On the Layout tab (Headers and Footers – From Edge: 
settings) 

 Header = 0.5” 
 Footer = 0.5” 

o Click OK 
 

• For Landscape pages: 
o On the Margins tab 

 Click to select Landscape orientation (be sure to do 
this first) 

 Top = 1.5” 
 Bottom = 1.0” 
 Left = 1.0” 
 Right = 1.0” 

 
Figure 7.  Set margins and page number 
position. 

 Gutter = 0” 
o On the Layout tab (Headers and Footers – From Edge: settings) 

 Header = 0.5” 
 Footer = 0.5” 

o Click OK 

Insert Page Numbers 
1. On the Insert tab, select Page Number  Top of Page in the Header & Footer group. 
2. From the resulting menu of page number styles, select Plain Number 3 (which contains no formatting or accents). 
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Change Starting Page Number 
There may come a time where you will need to modify the starting page number of a 
document.  For example, if you have saved each of your chapters as separate 
documents, you will need to make sure the first page of each chapter begins on the 
appropriate page number (the number following the last page of the previous 
chapter).  The steps below will guide you through this process: 

1. On the Insert tab, select Page Number  Format Page Numbers. 
2. From the Page Number Format dialog box, select Start At: and select the 

page number you want for the first page of your document (as shown in 
Figure 8).   

Figure 8.  Change starting page number 

Start a New Line, not a New Paragraph 
There are times when you may wish to force the text from one line to the next line without starting a new paragraph.  An example of 
this would be chapter headings (as shown in the example on the right).  You will want to keep these lines as one 
paragraph, so they stay on the same page after applying the Heading 1 style, and so they appear as 
one entry in your Table of Contents.  Another example where you might use this is in a quote or 
poem (where you wish to keep the lines together correctly at the top and bottom of a page). 

 
Figure 9.  New line 

1. If your formatting marks are not visible, turn on the Show/Hide non-printable characters by following the steps in the 
section above. 

2. If there is currently a paragraph mark between the first and second lines, delete this now (place your cursor at the 
beginning of the second line, and hit the Backspace key on your keyboard to bring the two lines together). 

3. To create a new line, place your cursor immediately in front of the text you wish to appear on the second line. 
4. Hold down the Shift key and press the Enter key. 
5. This will enter a New Line character (as shown at the end of the CHAPTER 1 line above) 

Landscape Pages with Portrait Page Numbers 
Within your thesis document, you may have pages which require landscape orientation, such as pages that contain wide tables or 
images.  Simply modifying the page orientation will not correct the page numbering position for you.  The easiest way to insert page 
numbers into your landscape pages is to download our LandscapePages.docx file to your thesis folder from our website 
(http://cs.its.uiowa.edu/sda/documents/LandscapePages.doc), then follow the instructions within the document.  The UI Thesis 
Template does not need to be attached to the LandscapePages.doc file in order to use this method. 

Use the Template to format your document 
Apply Styles to your paragraphs 
The template will allow you to incorporate consistent formatting to your thesis documents with ease.  However, simply attaching 
the template will not automatically format your document for you.  You will need to go through and apply the appropriate styles to 
the content within your document.  For your convenience, we have included definitions of the styles used within this template, 
which will assist you in determining the appropriate Style to paragraphs within your documents.  To view these definitions, please 
see the Definition of styles used within the UI Thesis Template section of this document. 

To apply a specific style to individual paragraphs 
1. Place your cursor in the paragraph where you would like to apply the style. 
2. On the Add-Ins tab, locate the appropriate style in the Thesis Template toolbar, and click the style button. 

To apply a specific style to multiple paragraphs  
For multiple paragraphs with of the same style, you can quickly apply the style formatting to all of the paragraphs (rather than 
clicking on each paragraph to apply the appropriate style) by following the steps below: 

1. Place your cursor at the beginning of the first paragraph. 

2. Scroll down the page until you locate the next paragraph style change (e.g., if you are applying the “Normal” style to 
multiple paragraphs, you would scroll down until you find a bulleted/numbered list, heading, quote, etc.). 

3. Hold down the Shift key, and then click at the end of the last paragraph of the same style (doing so will select all paragraphs 
between step A and step C). 

4. On the Add-Ins tab, locate the appropriate style and click the style button. 

http://cs.its.uiowa.edu/sda/documents/LandscapePages.doc�
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Replace the UI Thesis Template with a Modified or New Version 
If you have requested a customized template from ITS, or would like to replace your existing template with a newer version of the 
template, please follow the steps below. 

Please note:  If you have manually changed the default font or changed or added any styles to your existing template, you may want 
to save a copy of your old template under a new name to allow you refer back to the modified styles. 

1. Open your thesis document in Microsoft Word 2007. 

2. Determine where your template is stored on your computer: 

a) Click the Office Button and select Word Options. 

b) From the Word Options dialog box, click Add-Ins. 

c) From the Add-Ins portion of the dialog box, find the Manage: drop-down list.  Select Templates from the list and click 
the Go button. 

d) From the Templates and Add-ins dialog box, write down the entire path that displays in the Document Template field. 

3. Close any open thesis document(s). 

4. Delete any previous copies of the UI Thesis Template.dot file that you have on your computer: 

a) Search your local drives, external hard drives (including USB Keys) and network drives (where you may have saved a 
copy of the template), and delete all copies of the UI Thesis Template.dot.  This includes the copy located in the path in 
step 2d above. 

5. Download and unzip the new template file from the ITS website or your email message (if a customized copy of the 
template was emailed to you from ITS). 

6. Copy the UI Thesis Template.dot file, and paste it into your thesis folder (which should be the path noted in step 2d above). 

7. Reattach and update each of your thesis documents to the new template: 

a) Click the Office Button and select Word Options. 

b) From the Word Options dialog box, click Add-Ins. 

c) From the Add-Ins portion of the dialog box, find the Manage: drop-down list.  Select Templates from the list and click 
the Go button. 

d) From the Templates and Add-ins dialog box, click the Attach button to navigate to the Thesis folder. Select the UI 
Thesis Template.dot file, and click the Open button to return to the Templates and Add-ins dialog box 

e) Place a check in the check box next to Automatically update document styles. 

f) Click the OK button to attach the template and return to your document.  You should now see the list of styles 
available on the Add-ins tab. 

All previously applied styles should now be updated - scroll through and spot check to verify.   

Change the Default Font of the UI Thesis Template 
The UI Thesis Template defaults to Times New Roman font.  This font was selected as the default because it requires the least 
amount of manual formatting changes.  If you would like to change the default font for the UI Thesis Template, please follow the 
steps below: 

1. Open a file that has already been attached to the UI 
Thesis Template.dot file 

2. If prompted, select Enable Macros. 

3. On the Home tab, click the Dialog Box Launcher in the 
Styles group (as shown in Figure 10).  You will now 
see the Styles menu presented on the right. 

 
Figure 10.  Styles Dialog Box Launcher 

4. On the Styles menu, hover your mouse over the Normal style (to be presented with the drop-down arrow), then click and 
select Modify… to modify the style’s font. 

5. In the resulting Modify Style dialog box, select a font name and font size that is acceptable to the Graduate College* (from 
the appropriate drop-down menus under Formatting). 

6. Remove the checkmark next to Add to Quick Style list. 
7. Click to select New documents based on this template.  
8. Click the OK button to save your changes. 

9. Close your file, and click Yes to save the changes. 
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10. A second dialog box should appear asking, You have modified styles, building blocks (such as cover pages or headers), or 
other content that is stored in “UI Thesis Template”.  Do you want to save the changes to “UI Thesis Template”?  Click Yes 
(otherwise the template will revert back to the default of Times New Roman). 
Please note: By answering Yes to save the changes to your template, all existing documents that have already been 
attached to the template will display the new default font the next time they are opened. 

11. If you are presented with another dialog box stating Privacy warning: This document contains macros, ActiveX controls, 
XML expansion pack information, or Web components.  These may include personal information that cannot be removed 
by the Document Inspector., click OK to continue 

*To determine which font styles and sizes are acceptable to the Graduate College, please refer to the Graduate College Thesis 
Manual, or contact the Graduate College directly. 

Footnotes 
Insert a Footnote 
To insert a footnote in your document, follow the steps below: 

1. Place your cursor in the location where you wish to add the footnote. 

2. On the References tab, locate the Footnotes group and click Insert Footnotes. 
3. Add your footnote text at the bottom of the page. 

Modify the Footnote Separator Line and/or Footnote Continuation Separator Line 
A common first deposit comment refers to the location of the footnote separator lines and continuation notices – these need to line 
up with the left margin of the document.  If you need to modify your footnote separator and/or continuation separator line, please 
follow the steps below:   

1. On the View tab, change your Document 
View to Draft. 

2. On the References tab, click Show Notes 
within the Footnotes group – the 
Footnotes will now be displayed in a 
separate pane at the bottom of your 
document. 

3. In the Footnotes pane (the lower half of 
your window), select the type of 
separator line you would like to modify 
from the Footnotes: drop-down menu. 

 
Figure 11.  Footnote pane. 

Please note:  To change the separator that appears between the document text and notes, click Footnote Separator.  To 
change the separator for notes that continue from the previous page, click Footnote Continuation Separator. 

4. To left-align a separator line, place your cursor at the beginning of the line and hit the Backspace key on your keyboard to 
remove the extra space. 

5. Repeat steps 3 -4 for each separator line you wish to adjust. 
6. On the View tab, change your Document View to Print Layout to return to your previous view and verify the changes. 
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Captions, Notes and Sources 
In addition to including styles for figures and tables (see 
Figures 12 and 13) there are also a few other features 
and styles pertaining to your figures and tables that will 
be helpful while formatting your documents.  Please 
review the additional information below pertaining to 
figures and tables. 

Insert a Figure or Table Caption 
Earlier in this document, we explained the benefits of 
using styles to format your paragraphs, such as saving 
you time and effort, and ensuring consistency).  Another 
way to save you time and effort is to take advantage of 
Microsoft Word’s Insert Caption feature.   

 
Figure 12. Style used to format figures 

 
Figure 13. Style used to format tables 

Inserting your figure and table captions in the manner explained below will allow you to automatically generate your List of Figures 
and List of Tables, saving you from manually typing your lists.  Select the manner which is most appropriate for your document 
below, then follow the steps for inserting a figure or table caption. 

If you have not typed your caption description : 
1. Insert a new paragraph before or after your figure/table where you would like to insert your caption. 

Please note: Do not select the paragraph mark. 
2. Place your cursor on the new paragraph line (added in step 1). 

3. On the References tab, click Insert Caption from the Captions group  
Alternative Method:  On the Add-Ins tab, click the Insert Caption button from the Thesis Template toolbar. 

4. In the Caption dialog box, select the appropriate label for your caption (Figure or Table). 
5. Click OK to close the dialog box and return to your document. 

6. Add your caption description after the caption label. 

If you have already typed your caption description: 
1. Place your cursor at the beginning of the line containing your caption. 

Note: Do not highlight or select any of your caption text, label or numbering. 
2. If you have already manually typed your caption label and number (e.g., Table 1), delete them now. 

3. On the References tab, click Insert Caption from the Captions group 
Alternative Method:  On the Add-Ins tab, click the Insert Caption button from the Thesis Template toolbar. 

4. In the Caption dialog box, select the appropriate label for your caption (Figure or Table). 
5. Click OK to close the dialog box and return to your document. 

Please note:  The Caption can NOT be inside the figure or table – the caption must exist in a paragraph of it’s own and match the font 
of the thesis text. 

Modify Caption Number for a Figure or Table  
If you plan to number your figure or table captions to include the chapter number (e.g., Table 3-1, Table 3-2, Table 3-3, etc.), you will 
need to do a little manual formatting to implement this.  There are two methods for doing so, depending on how you have your 
document(s) set up.  Select the manner in which you have your document laid out below, then follow the steps for modifying the 
caption number.  

If each chapter of your thesis is contained in a separate document, follow these steps: 
1. Insert the caption for your first figure or table (see “Insert Captions for Figures or Tables” for instructions).  The caption 

should display as “Figure 1” or “Table 1”. 
2. Arrow back to place your cursor directly before the “1” (when 

moving across the “1”, you will see that it displays with a grey box 
highlighting it, as shown in Figure 14.this tells you that caption is 
linked to the document, and will allow you to create your List of 
Figures or List of Tables with ease). 

 

 
Figure 14.  Step 2 



13 

UI Thesis Template for Word 2007 ver 2.1  Spring 2010 

3. Type the chapter number and separator before the “1” (e.g., if this is the first image in Chapter 3, you would insert 
“3-” immediately before the caption number). 

4. Your caption should now read as “Figure 3-1” or “Table 3-1” (as 
shown in Figure 15). 

5. Repeat steps 1-4 for the remaining Figures or Tables in your 
document.  

 
Figure 15.  Modified figure caption after including chapter 
designator. 

Please note:  Do not delete or modify the caption number that is inserted by the “Insert Caption” feature (e.g., the “1” in step #1 
above).  If you would like to change the starting caption number, please follow the steps below to do so. 

If all of your chapters are combined into one document, please follow these steps: 
When all of your chapters are contained in one document, you will find that captions will begin at 1 for the first caption, and 
continue in ascending order for each caption that follows (e.g., Table 1, Table 2, Table 3, etc.), regardless of the chapter in which 
they reside.  If you would like to include the chapter number in the caption, and would like to restart the caption numbering in each 
chapter (e.g., Table 1-1, Table 1-2, Table 2-1, Table 2-2, etc.), you will need to follow the steps below to do so. 
Please note:  Do not use the “Include Chapter Number” option within the Insert Caption dialog box in Word  – you will need to follow 
the steps below. 

1. Insert the captions for all figures or tables for your first chapter 
as you normally would (see “Insert Captions for Figures or 
Tables” for instructions).   

 
Figure 16.  Step 2 (first figure in Chapter 2) 

2. Within Chapter 2, find your first figure or table, and insert the caption (if you have not already done so), as shown in Figure 
16..  

3. Press Alt + F9 to view the field codes – you will 
see something similar to  
{ SEQ Figure \* ARABIC } where your Caption 
should appear. 

 
Figure 17.  Field code for first figure in Chapter 2 

4. Modify your field SEQ so that it reads as 
follows, which will reset the sequence 
number to 1: 

{ SEQ Figure \r 1 \* ARABIC } 
 

Figure 18.  Modified SEQ code to reset the sequence number to “1”. 
Please note:  If you would like to start your numbering at a number other than 1, replace the “1” with the appropriate 
number. 

5. When finished, press Alt + F9 to switch back to your document (you should no longer see the field codes).   At this point, 
your caption will appear to be unchanged – you will need to update the field to reflect the changes (continue with the steps 
below). 

6. Press Ctrl + A to select the entire document. 

7. Press F9 to update the fields – your caption number should now display as 1, and each caption that follows will continue 
numbering in ascending order. 

8. Repeat steps 2 – 7 for each chapter in your document. 
9. When you have finished renumbering each chapter of your 

document, you can then type the chapter number and separator 
directly before each caption number (e.g., for Chapter 2, you can 
insert “2-“ prior to each caption number, so it will then display as 2-
1, 2-2, 2-3, etc.). 

 
Figure 19.  Renumbered figure caption after updating field 
codes and adding chapter designator. 

Modify Captions for Figures or Tables within an Appendix 
You may choose to include your figures or tables within an appendix (rather within the individual chapters).  To modify the figure or 
table captions to reflect the Appendix number and separator (e.g., for Appendix B, it would appear as Table B-1, Table B-2, etc.), 
please follow the appropriate steps below (depending on the layout of your document(s)). 
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If each appendix is included in a separate document, follow the steps below: 
1. Insert the caption for your first figure or table within your Appendix (see “Insert Captions for Figures or Tables” for 

instructions).  The caption should display as “Figure 1” or “Table 1”. 

2. Arrow back to place your cursor directly before the “1” (when 
moving across the “1”, you will see that it displays with a grey box 
highlighting it – this tells you that caption is linked to the  

 
Figure 20.  Step 2 

document, and will allow you to create your List of Figures or List of Tables with ease). 

3. Type the appendix letter and separator before the “1” (e.g., if this is the first image in Appendix B, you would insert “B-” 
immediately before the caption number). 

4. Your caption should now read as “Figure B-1” or “Table B-1”. 
5. Repeat steps 1-4 for the remaining Figures or Tables in your 

appendix. 
 

Figure 21.  Modified figure caption after including appendix 
letter and separator. 

Please note:  Do not delete or modify the caption number that is inserted by the “Insert Caption” feature (e.g., the “1” in step #1 
above).  If you would like to change the starting caption number, please follow the steps below to do so. 

If your appendix and thesis chapters are all included in one document, follow the steps below: 
When all of your chapters and appendices are contained in one document, you will find that captions will begin at 1 for the first 
caption, and continue in ascending order for each caption that follows (e.g., Table 1, Table 2, Table 3, etc.), regardless of the chapter 
or appendices in which they reside.  If you would like to include the appendix number in the caption, and would like to restart the 
caption numbering in each appendix (e.g., Table A-1, Table A-2, Table B-1, Table B-2, etc.), you will need to  
follow the steps below to do so. 

1. Within your first appendix, find your first figure or table, and insert 
the caption (if you have not already done so). 

 
Figure 22.  Step 1 

2. Press Alt + F9 to view the field codes – you will 
see something similar to  
{ SEQ Table \* ARABIC } where your Caption 
should appear. 

 
Figure 23.  Field code for first figure in Appendix A 

3. Modify your field SEQ so that it reads as 
follows: { SEQ Table \r 1 \* ARABIC } 
This will reset the sequence number to 1. 

 
Figure 24.  Modified SEQ code to reset the sequence number to “1”. 

Please note:  If you would like to start your numbering at a number other than 1, replace the “1” with the appropriate 
number. 

4. When finished, press Alt + F9 to switch back to your document (you should no longer see the field codes).   At this point, 
your caption will appear to be unchanged – you will need to update the field to reflect the changes (continue with the steps 
below). 

5. Press Ctrl + A to select the entire document. 
6. Press F9 to update the fields – you caption number should now display as 1, and each caption that follows will continue 

numbering in ascending order. 
7. Repeat steps 1 – 6 for each appendix in your document. 
8. When you have finished renumbering the captions within each 

appendix, you can then type the appendix number and separator 
directly before each caption number (e.g., for Appendix A, you can 
insert “A-“ prior to each caption number, so it will then display as A-
1, A-2, A-3, etc.). 

 
Figure 25.  Renumbered figure caption after updating 
field codes and adding appendix letter. 
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Add a Note or Source to a Table or Figure 
To add a Note or Source to a Table or Figure, please follow the steps below:  

1. If you have not yet done so, insert your table or figure, and the caption. 

2. Place your cursor on a new line after your table/figure/caption. 
3. On the Add-Ins tab, click Figures/Images or Tables to reveal the drop-

down menu. 
4. From the resulting menu, select Note/Source Line or Note/Source No 

Line, based on your preferences. 
(To understand the difference between Note/Source Line and 
Note/Source No Line, please refer to the Definition of styles used within 
the UI Thesis Template section of this document.) 

Please note:  Make sure you have at least three single (12pt) spaced lines 
between the note/source and the text of your thesis. 

 
Figure 26.  Add a note or source to your table/figure. 

Preliminary Pages 
Create Preliminary Pages 
The UI Thesis Template includes a macro which will automatically generate your Preliminary Pages for you based on the information 
you supply to the resulting questions.  

1. If you have not yet done so, attach the UI Thesis Template to a Microsoft Word document (see Attach the UI Thesis 
Template to your documents section of this document for instructions). 

2. From the Add-Ins tab, click the Prelims button.  An automated macro will begin and provide you with a brief description of 
the process in the Here’s What Happens Next dialog box.  Click OK to continue. 

3. When prompted to Name the New File, navigate to your Thesis folder, select a file name (or leave the default PrelimPages), 
and click Save. 
Warnings/Messages: 

Macro Messages:  If you receive any errors pertaining to macros, please see the instructions in the Macro Security 
Settings section and then try these steps again. 

Compatibility Message:  If you receive a message pertaining to the file format and compatibility when saving your 
Prelims document, please refer to the section below. 

4. An explanatory message will appear for each page, and you will be required to enter information about yourself, your 
committee members, your degree, etc.   

5. All optional pages will provide explanatory text, followed by a Yes or No question. 
6. The default for all questions is Y (for Yes) – please type N (for No) if you do not wish to include the optional page. 

When in doubt, it is recommended that you accept the default answer of Y(Yes) for all pages – it is much easier to remove 
an unnecessary page than to add a page at a later time. 

7. When your Prelims document is created, save the document to your Thesis folder. 

Compatibility Message (when generating Preliminary Pages or Doctoral Abstract) 
It is possible that you may receive the following message when generating your Prelims or Doctoral Abstract.  This is a due to the 
macros being originally created in a previous version of Word.  You are prompted to take one of the following actions: 

• Click OK to continue, or 
• Click Cancel to return to the Save As dialog box, and select “Maintain compatibility with Word 97-2003”. 

Taking either of these actions is fine – both actions have been tested, and the results are the same regardless of which route you 
take.  Additionally, the formatting for this document in Word 2007 is the same as in previous versions of Word. 

 
Figure 27.  You may receive this message while generating your Preliminary Pages or Doctoral Abstract document. 
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Delete an unwanted page within the Preliminary Pages 
You may find that after creating your Preliminary Pages, you no longer need a page you inserted.  In order to remove the page 
without modifying the section breaks and page numbering that is built into the macro, please follow the steps below: 

1. From the View tab, change your document view to Draft. 
2. Select the text you wish to delete (by dragging the mouse to highlight the text, or method of your choice). 

3. Press the Delete key on the keyboard. 
4. A flashing black line (also referred to as a mouse I-beam) appears on top of the Section Break (Next Page) line. 

5. Press the Delete key on the keyboard. 
6. Save the revised document. 

Please note:  We recommend verifying the deletion of the desired page(s) by returning to the Print Layout view. 

Create an External Abstract (PhD candidates) 
The UI Thesis Template includes a macro which will automatically generate your Preliminary Pages for you based on the information 
you supply to the resulting questions.  

1. If you have not yet done so, attach the UI Thesis Template to a Microsoft Word document (see Attach the UI Thesis 
Template to your documents section of this document for instructions). 

2. From the Add-Ins tab, click the Create Doctoral Abstract Separate button.  An automated macro will begin and provide you 
with a brief description of the process in the Abstract Bound Separately dialog box.  Click OK to continue. 

3. When prompted to Name the New File, navigate to your Thesis folder, select a file name (or leave the default 
DoctoralSeparate.docx), and click Save. 

Warnings/Messages: 
Macro Messages:  If you receive any errors pertaining to macros, please see the instructions in the Macro Security 
Settings section and then try these steps again. 
Compatibility Message:  If you receive a message pertaining to the file format and compatibility when saving your 
Prelims document, please refer to the section below. 

4. An explanatory message will appear for each page, and you will be required to enter information about yourself, your 
committee members, your degree, etc.   

5. When your Doctoral Abstract document is created, save the document to your Thesis folder. 

Add an additional supervisor to Prelims and Doctoral Abstract 
If you have more than one Thesis Supervisor, you will need to add additional lines to your Preliminary Pages and Doctoral Abstract.  
In order to do this, you will need to follow the steps below: 

1. Change Thesis Supervisor: to Thesis Supervisors: 

2. Place your cursor on the Thesis Supervisors: line 

3. Scroll up within your document so the Thesis Supervisors: line is at the top of the screen (by the ruler). 

4. If your paragraph markers and line breaks are not displayed, press Ctrl + Shift + F8 simultaneously on your keyboard. 

Please note:  When following the steps below, you will initially place the supervisor with the longest name and title on the 
first line, and the one with the shorter name and title on the second line.  This is only temporary – you can place them in the 
order that is most appropriate after you have created the additional line. 

5. You should see a new line marker ( ) at the end of the Thesis Supervisors: line.  If you do not see the new line marker, 
you can enter one now by pressing the Shift key and Enter key simultaneously. 

6. Type the title and name of your second Thesis Supervisor on the line directly below the first supervisor. 
Please note:  When following these steps, you will initially place the supervisor with the longest name and title on the first 
line, and the one with the shorter name and title on the second line.  This is only temporary – you can place them in the 
order that is most appropriate in step 12 below. 

7. With your cursor still on the Thesis Supervisor line, make a note of the starting measure of the first line (a), the ending 
measure of the first line (b) and the starting measure for the first supervisor’s title (c). 
Please see the image below for a visual. 



17 

UI Thesis Template for Word 2007 ver 2.1  Spring 2010 

 
Figure 28. Steps 1 – 7 

8. Click and drag the Hanging Indent marker on the ruler to the starting measure point of the first Supervisor’s title (b) – the 
triangle only, not the square below the triangle..   
Hint: For more precise control, hold down the Alt key while dragging. 

9. Click and drag the First Line Indent marker on the ruler to the starting measure point of the first line (a).   

10. Click the Left Align button to align the text to the left. 

11. Replace the spaces after Thesis Supervisors: with a tab in order to line up both names. 
Hint:  Place your cursor immediately before the first Supervisor’s name, and hit the Delete button twice to remove the two 
spaces.  Then, hit the Tab key to move the first Supervisor over to line up with the second supervisor. 

12. If needed, change the order of the supervisors by select and drag, or cut and paste.  
Please see the image below for a visual. 

 
Figure 29.  Appearance after steps 8-12. 

13. PhD Candidates: Copy and paste these fixed lines into your prelim pages and doctoral abstract document. 

• Be sure include the paragraph mark by the second advisors name when you copy, and 

• Do NOT include the section break or last paragraph mark on the page when you copy and paste. 
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Table of Contents / List of Figures / List of Tables 
Insert Table of Contents 
This should be done at the end of each document that is part of your thesis, rather 
than within the preliminary pages.  The Table of Contents created in the preliminary 
pages is simply a placeholder – you will later update, unlink and copy the Table of 
Contents from your main document(s), and paste them in the appropriate location 
in the preliminary pages. 

1. Open your thesis document (not the Prelim Pages). 
2. Scroll to the end of the document* 
3. Click the Insert tab 
4. From the Pages group, click Page Break 
5. Click the References tab 
6. From the Table of Contents group, select Table of Contents, and then 

Insert Table of Contents from the resulting menu 
7. In the Table of Contents dialog box, select the following options: 

• Check Show page numbers 

• Check Right align page numbers 
• Choose the Tab leader you would like to use 

Uncheck Use hyperlinks instead of page numbers 

• Select From Template next to the Formats: drop-down menu 

 
Figure 30.  Steps 3 – 6. 

(under the General section) 

• Select the number of levels you wish to 
show from the Show levels field (please 
refer to the Graduate College Thesis 
Manual to determine the minimum 
number of levels allowed) 

8. Click OK to save your changes and generate your 
Table of Contents. 

*We encourage you to insert your Table of Contents (TOC) at 
the end of your document, rather the beginning.  This will 
ensure that your page numbering is correct when you copy 
and paste the TOC into your preliminary pages document. 

 
Figure 31.  Options for step 7. 

Insert List of Figures or List of Tables 
This should be done at the end of each document that is part of your thesis, rather than within the preliminary pages.  The List of 
Figures/List of Tables created in the preliminary pages is simply a placeholder – you will later update, unlink and copy your lists from 
your main document(s), and paste them in the appropriate location in the preliminary pages 
Please note:  This will only work if you have used the Insert Caption feature (located within the UI Thesis toolbar, or under the 
References tab within the Captions group).  For information pertaining to captions, please see the Insert Figure/Table Captions 
section of this document. 

1. Open your thesis document (not the Prelim Pages). 
2. Scroll to the end of the document* 

3. Click the Insert tab 
4. From the Pages group, click Page Break 
5. Click the References tab 

6. From the Captions group, click Insert Table of Figures 
 

Figure 32.  Step 6 
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7. In the Table of Figures dialog box, select the 
following options: 

• Check Show page numbers 

• Check Right align page numbers 

• Choose the Tab leader you would like to use 

• Uncheck Use hyperlinks instead of page 
numbers 

• Select From Template next to the Formats: 
drop-down menu (under the General 
section) 

• Select either the appropriate caption type 
from the Caption label drop-down menu 
(either Figure or Table) 

• Check Include label and number 

8. Click OK to save your changes and generate your 
Table of Contents. 

 
Figure 33.  Options for Step 7 

Update all lists (Table of Contents, List of Figures and List of Tables) in your document 
If you have made changes to your document after creating your Table of Contents, List of Figures and/or List of Tables (e.g., modified 
caption name or chapter title, or added additional content which will modify the page numbering) , you can reflect these changes by 
updating all of the fields within your document. 

1. Press Ctrl + A to select the entire document. 

2. Press F9 on your keyboard to update.  
3. If prompted to update the page numbers only, or update the entire table, select Update entire table, and click OK to return 

to your document. 
4. Repeat these steps for each list in your document (e.g., Table of Contents, List of Figures and List of Tables) 

Add your Table of Contents (TOC), List of Figures or List of Tables to your Preliminary Pages 
The information contained in the next two sections should be done in sequential order from the computer you plan to print from or 
create an electronic copy for submission (PDF).  Changing to a different computer or printer may modify the page numbers and page 
breaks, as the number of characters per line and lines per page are governed by the default printer for that document. 

Update your Table of Contents, List of Figures or List of Tables 
1. Click to the left of the first line 

of the Table of Contents/List of 
Tables/List of Figures to select 
the entire list (the entire table 
should appear to be highlighted 
in grey) 

2. Press F9 on your keyboard 
3. Select Update the entire table 

4. Click OK. 
Once you have updated your tables, you 
will then need to follow the steps in the 
next section in order to place them in 
your Preliminary Pages document. 

 
Figure 34.  Step 1 (Update Table of Contents/List of Figures/List of Tables). 
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Unlink the Table of Contents, List of Figures or List of Tables, then copy to your Preliminary Pages 
Please note:  Prior to following these steps, make sure you have followed the steps for updating your tables in the previous section to 
update your lists. 

1. Click to the left of the first line of your Table of Contents/List of Tables/List of Figures to select the entire list (the entire 
table should appear to be highlighted in grey) 

2. Press the Ctrl + Shift + F9 keys simultaneously.  Your table should no longer be “linked” to the document (e.g., when you 
click within the list of items, they should no longer appear to be highlighted in grey). 
Please note:  If your text is now blue and underlined (displaying as a hyperlink), follow steps a) and b) below, otherwise, 
continue with step 3. 

a) With the text still selected, click the Add-ons tab 
b) Click the Default Paragraph Font style from the UI Thesis Template 

Note: You may need to reinsert italics, international fonts and/or special symbols if these are included in your list. 
3. With the entire list still selected, press Ctrl + C to copy the text. 
4. Press Ctrl + Z to undo the action (essentially re-linking the table). 

5. Save your document (the text you copied will still be located on your Clipboard). 
6. Open your Preliminary Pages document. 

7. Scroll to the location where you wish to insert your Table of Contents, List of Figures or List of Tables, and click your mouse 
to position your cursor. 

8. Press Ctrl + V to paste the text from your main document into the Preliminary Pages. 
9. Click in front of the first Heading 2 (your first order subdivision/subheading) in each chapter and press Enter on your 

keyboard to insert a single blank line after the chapter title (Major Division Heading), as required by the Graduate College. 

Create one electronic file from multiple files 
Beginning with the Fall 2009 semester, all master’s theses and doctoral dissertations must be submitted to the Graduate College in 
electronic format (with the exception of MFA theses).  We recommend you keep your preliminary pages in a document separate 
from the main body of your thesis (in other words, keep these as separate documents).  Additionally, if your document contains 
many figures or tables, we also encourage you to save each chapter as a separate Word document, as the file can become 
cumbersome the larger it becomes. You can still create one electronic file while keeping your Word documents separate, and this 
can be done using Adobe Acrobat Professional or the PDF Conversion Tool on the ETD website.   

For assistance or additional information pertaining to file conversion for ETD, please see the Graduate College’s ETD website:  
http://www.grad.uiowa.edu/theses-and-dissertations/etds.  

Troubleshooting 
I no longer see the Add-Ins tab (or the UI Thesis Template styles within the Add-Ins tab) 
If you open your thesis document and the Add-Ins tab no longer appears (or you do not see the UI Thesis Template styles within the 
Add-Ins tab), it is likely that the UI Thesis Template is no longer attached to your thesis document. This can result if the document 
you accessed is not located within the folder containing the UI Thesis Template.dot file, or you have not properly attached the 
template to your document.  If you are working between several computers, make sure you copy the entire folder containing your 
thesis documents between computers.  In order to access the UI Thesis Template styles again, you will need to re-attach the 
template to your document(s).  Please refer to the Getting Started section for instructions. 

I can’t print my Figure 
If you have created Drawing Objects within Word, and you are unable to print them, please follow the steps below. 

1. Click the Office Button and select Word Options. 
2. Select Display, and place a checkmark next to Print drawings created in Word (under the Printing Options section). 
3. Click OK to save your changes. 

  

http://www.grad.uiowa.edu/theses-and-dissertations/etds�
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I can’t view my Figure or Equation in my document – instead, I have an outline box where it should 
appear 

1. Click the Office Button and select Word Options. 
2. Select Advanced and scroll down to the Show document content section. 
3. Uncheck Show picture placeholders. 

4. Place a checkmark next to Show drawings and text boxes on screen. 
5. Click OK to save your changes. 

Only the bottom part of my Figure or Equation appears on my screen or when I print my document 
1. Click on the Figure or Equation to select it. 
2. From the UI Thesis Template, click on the Figure/Image Para style (for figures), or Equation Para style (for equations). 

3. If you are still unable to view or print your equations, please see I can’t print my Figure or Equation and I can’t view my 
Figure or Equation in my document section of this document. 

Thesis Formatting Best Practices 
The thesis process can seem very overwhelming as you begin – there are many deadlines to meet, guidelines to remember and 
processes to learn.  However, we have provided you with some “Best Practices” in an effort to at least make the formatting process 
as straightforward as possible.   

1. Never, ever open the UI Thesis Template.dot file.  Remember to attach the template to your new and existing documents, 
as explained in this document. 

2. Save your documents often.  There is nothing worse than spending a significant amount of time typing or formatting your 
document, and then have your application crash on you or experience a power outage.  When working on your documents, 
try to remember to save every 15 minutes or so - if your computer crashes while you’re working, you’re only out 15 
minutes of work (rather than 2 or 3 hours). 

3. Make backup copies of your documents on a regular basis, and store them in multiple locations.  Save a copy to a USB key 
or external hard drive.  E-mail a copy to your personal email account (and CC: a friend or family member as well!).  Use 
Files@Iowa (http://its.uiowa.edu/support/files/) to save a copy, which can be accessed from on or off campus.  In the event 
that your hard drive dies, or worse – you experience a natural disaster, such as a flood, hurricane or fire – your documents 
will be safe if you have emailed a copy to a friend or saved a copy to your network drive. 

4. When working on multiple computers, copy the entire Thesis folder between locations.  This will allow your documents to 
stay attached to the UI Thesis Template.   

5. Copy files to your local workstation before you begin.  Working on files located on a USB key or external hard drive can be 
cumbersome, especially if you have multiple tables or images contained in your document.  Before you begin, copy the 
Thesis folder to your workstation and then open you’re your documents.  When you’re finished, make sure you save the 
files and copy them back to your USB key or external hard drive. 

6. Keep your Preliminary Pages separate from the main body of your thesis.  The section breaks and page numbering styles 
included in the Preliminary Pages can result in incorrect numbering location and style for the body of your thesis if these 
documents are combined.  If you need to submit an electronic copy for any reason, you can create a PDF from multiple 
Word documents and avoid page numbering issues.  Please see the Create one electronic file from multiple files section for 
instructions. 

7. If your thesis contains many figures or tables, save each chapter as a separate Word document.  Working with documents 
which contain multiple figures or tables can result in a large file size.  As a result, the file can become difficult to work with, 
and also runs the risk of becoming corrupt.  You can later create a single PDF from multiple files by following the steps 
under the Create one electronic file from multiple files section. 
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Definition of styles used within the UI Thesis Template 
The UI Thesis Template includes a number of “styles” which you will need to apply to the appropriate paragraphs within your 
document, and these styles are available via the Add-Ins tab after you have properly attached the template to your document(s).  
Below, you will find definitions of these “styles”, including an explanation of what formatting is applied when the style is selected.  It 
will also assist you with determining the appropriate style for sections within your document.  

UI Thesis Template Style Definitions 

UI Thesis Template 
Style Name Style is used for... 

Normal The text within the body of the thesis. Provides a true 2-to-1 ratio required by Graduate 
College. 

Normal No Indent Used when no indentation is necessary and 'Normal' style is needed. 
Used primarily for bulleted/numbered lists and paragraphs following bloke quotes. 

Normal Indented Indents left and right margins 0.5" while double-spacing  
(24 pt) the paragraph. Provides the required 2-to-1 ratio. 

Heading 1 Major Division Heading - used for Chapter titles, References, List of Abbreviations, and 
Bibliography headings. 

Heading 1 No Page Break Major Division Heading - used for Appendix when on their own page. Must enter manual page 
break before it. 

Heading 1 Before Heading 2 Major Division Heading - Used for Chapter title that is IMMEDIATELY followed by a Heading 2. 
To fix spacing between the 2 headings. 

Heading 2 First-order Subdivision/Subheading (Grad College Terminology). 

Heading 3 Second-order Subdivision/Subheading (Grad College Terminology). 

Heading 4 Third-order Subdivision/Subheading (Grad College Terminology) 

Heading 5 Fourth-order Subdivision/Subheading (Grad College Terminology). 

Heading 6 Fifth-order Subdivision/Subheading (Grad College Terminology) 

Insert Caption Used to insert Table and/or Figure captions. MS Word uses the Caption style to build the List 
of Tables and/or List of Figures. 

Caption Style Formats Table and/or Figure captions. MS Word uses the Caption style to build the List of 
Tables and/or List of Figures. Use Insert Caption to get correct numbering. 

Insert Foot/End Note Inserts footnote/endnote reference mark, enabling entry of footnote/endnote text. 

Tables Button Styles available for formatting tables. 

Table Para Formats Table maintaining true 2-to-1 ratio. Reduces font to 11 pt to fit more on page. 

Table Top Bottom Lines Formats the Table to have the Top most and Bottom most lines Black. Opens insert table 
dialog if needed. 

Table All Lines Formats the Table to have black on All lines of table. Opens insert table dialog if needed. 

Table Boxed Formats the Table to have Black Lines around the outside edge of table. Opens insert table 
dialog if needed. 
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UI Thesis Template Style Definitions (Continued) 

UI Thesis Template 
Style Name Style is used for... 

Figures/Images Button Styles available for formatting Figures. 

Figure/Image Para Formats Figure/Image paragraphs by clicking to select the Figure/Image then clicking the 
toolbar button. Allows you to see the complete figure or image rather than the bottom 24 pts. 

Insert Picture Brings up the Insert Picture from file dialog box. 

Note/Source Line Formats notes for the table or figure to be single-spaced (12 pt) with double-spacing (24 pt) 
between each line of text. Also draws a separator line above the first note or source. 

Note/Source No Line Formats notes for the table or figure to be single-spaced (12 pt) with double-spacing (24 pt) 
between each line of text. Use Note/Source Line for notes associated with figures. 

Lines - 1 Used for spacing. Adds one single-spaced (12 pt) line. 
(i.e. around Tables and/or Figures.) 

Lines - 3 Used for spacing. Adds three single-spaced (12 pt) lines. 
(i.e. around Tables and/or Figures.) 

Equation Para Formats equation elements, such as superscript or subscript, to allow for added character 
height. 

Reference Para Formats References with single-spaced citations and double-spacing between each. 

Block Quote Formats paragraph with a first-line indentation, single-spacing and a left and right indented 
margin. (See Extended Quote also.) 

Extended Quote Formats paragraph without a first-line indentation, single-spacing and a left and right 
indented margin. (See Block Quote also.) 

Endnote Reference Formats the endnote reference number. 

Endnote Text Formats the endnote text. (12 pt) 

Footnote Reference Formats the footnote reference number. 

Footnote Text Formats the footnote reference text. (11 pt) 

Default Paragraph Font Resets the font in the paragraph back to the font and size specified by the style. 

Prelims This toolbar button starts an interactive macro that will create the required Preliminary 
Pages.  PC users:  To resolve non-functioning macros or macro security warnings, please refer 
to the Macro Security Settings section of this document. 

New Doc With UITemplate Begins a new document, attached to the template, with the proper margin settings. 

DocABS_Separate This toolbar button starts an interactive macro that will created PhD students Doctoral 
Absract.  PC users:  To resolve non-functioning macros or macro security warnings, please 
refer to the Macro Security Settings section of this document (PC users). 
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For Assistance: 
Should you find you have thesis-related concerns, we have provided you with a number of available resources.  Please review the 
information below and determine the appropriate contact based on your needs. 

Graduate College (Academic Affairs Office) 
What you should know: 

As the Graduate College creates and governs the guidelines pertaining to your thesis, you will need to contact them for any 
guideline or acceptability concerns you may have.  Oftentimes, it is most helpful if you have an example of your concern to 
present to the examiner.  With that, we encourage you to stop by the Academic Affairs office and ask to speak to an examiner 
with a hard copy, or fax a copy of your concern and ask that it be given to an examiner.    

If you have the following (or similar) acceptability concerns, please contact the Graduate College: 
• Which fonts and font sizes are acceptable for my thesis documents? 
• Is this formatting acceptable / Do I have this item formatted correctly? 
• Would you be able to take a look at my documents and see if I’m on the right track? 
• How can I create a PDF from multiple Word files for my electronic submission? 

Contact Information: 
Graduate College (Academic Affairs Office) 
6 Gilmore Hall 
319-335-2144  
319-335-2806 (fax) 
gradcoll@uiowa.edu (email) 
http://www.grad.uiowa.edu (website) 

Additional Information: 
In addition to obtaining assistance with specific formatting concerns, the 
Graduate College’s “Theses & Dissertations” page 
(http://grad.uiowa.edu/theses-and-dissertations) also allows you to: 

• Obtain a copy of the Graduate College Thesis Manual 
• Learn about the ETD (Electronic Theses and Dissertations) 

submission process and policies 
• Graduation/Thesis-related fees 
• Upcoming Thesis Defenses 

ITS Help Desk / Thesis & Dissertation Technical Support 
What you should know: 

If you find that any questions or concerns pertaining to the technical portion of formatting your thesis documents (e.g., you are 
unable to format an item so it matches the Graduate College’s requirements, questions/concerns about a feature or function in 
Microsoft Word, etc.), please contact the ITS Help Desk for assistance.   

Please note:  ITS will be not be able to answer questions pertaining to guidelines and acceptability – these questions or 
concerns will need to be directed to the Graduate College.   

Contact Information: 
ITS Help Desk 
2800 UCC (2nd floor, University Capital Centre) 
319-384-HELP (4357) 
Its-helpdesk@uiowa.edu (email) 
http://helpdesk.its.uiowa.edu (website) 
http://cs.its.uiowa.edu/sda (Thesis & Dissertation 

Preparation Page) 

*All requests for technical assistance must begin with 
the ITS Help Desk. 

Additional Information: 
In addition to providing 1st tier support for Microsoft Office 
applications and thesis formatting concerns, the ITS Help Desk 
provides you with many technical resources available on their 
website, including (but not limited to): 

• Access to several licensed software applications available 
for use by U of I students, faculty and staff at no cost  

• Licensed software applications available at reduced cost, 
including Microsoft Office, Adobe Products, reference 
software and more 

• A variety of support centers to assist you with everything 
from setting up your wireless connection to setting up 
your email account (and nearly everything in-between) 

• Assistance with purchasing a new computer 

mailto:gradcoll@uiowa.edu�
http://www.grad.uiowa.edu/�
http://grad.uiowa.edu/theses-and-dissertations�
mailto:Its-helpdesk@uiowa.edu�
http://helpdesk.its.uiowa.edu/�
http://cs.its.uiowa.edu/sda�
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Microsoft Word 2007 Resources 
You can learn more about Microsoft Word 2007 and/or how to utilize various features and functions within Word 2007 in either of 
the following ways: 

Microsoft Word Help 

Click on the Microsoft Office Word Help button  in the upper right-hand corner of Word 2007 to launch Microsoft Word Help 
(or press F1 on your keyboard). 

Microsoft Office Online 
Go to http://office.microsoft.com and click Help and How-to to access a plethora of training resources, demos webcasts, 
podcasts and much more. 

Microsoft’s Support Knowledge Base 
Go to http://support.microsoft.com for a searchable knowledge base containing known issues and instructions for resolving 
them. 

 

http://office.microsoft.com/�
http://support.microsoft.com/�
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